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On the cover: A big-leaf mahogany population (204 hectares) in southeast Pard after 70 years
of simulation. Dark circles represent mahogany trees, sized according to diameter. The red
squares represent disturbances with the darker red portions representing the zone of
recruitment. Seasonal streams are shown in blue and the site boundary is shown in white.
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Model Schematic. The model interface as it appears when installed on your computer.
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Free Landis & Grogan, Mahogany Growth & Yield

1 MODEL INTRODUCTION

In recent decades big-leaf mahogany, Swietenia macrophylla, has been intensively harvested
across its natural range in tropical South America. Future timber production from natural forests
will depend on protection and stewardship of surviving commercial populations through
sustainable management practices. The Big-Leaf Mahogany Growth & Yield Model presented
here projects population recovery and timber production from simulated harvests of mahogany in
the Brazilian Amazon. The model offers forest managers a computer-based tool for assessing
the impact of current management practices on both pre-installed example mahogany
populations and on user-entered populations. The growth & yield model uses the NetLogo 4.1.2
(Wilensky 1999) platform and can be installed on computers using Windows or Mac OS X
operating systems.

The growth & yield model functions (algorithms) are derived from demographic data collected
annually during 1995-2009 for nearly 600 mahogany trees and many thousands of seedlings,
saplings and poles at multiple field sites in southeast Pard and Acre. Model simulations can be
run with or without harvesting. Under logging scenarios, the model harvests (kills) trees at
specified intervals. During intervals between harvests, surviving individuals grow, reproduce,
and die at rates observed in field studies. Harvest simulations are based on current legal
management practices (60 cm minimum diameter cutting limit, 20% commercial-sized tree
retention rate, minimum 5 commercial-sized trees / 100 ha retention density, 30-year cutting
cycle). Forest managers can input mahogany population data from field inventories in order to
project recovery and production outcomes following multiple harvests at legal management sites.
Harvest parameters can be changed to view population and timber production outcomes under
alternative management scenarios by adjusting one or more of the four management practices.

The model interface allows harvest simulations to be set up and run by clicking on a series of
buttons as explained in the sections to follow. For a given starting population and harvest
scenario, each ‘run’ will yield a different outcome (number of trees and commercial volume
harvested, surviving density, etc.). This occurs because the model functions for survival, growth,
and reproduction are recalculated each time step using a random error term, leading to different
long-term outcomes. For this reason, average outcomes from multiple simulations will best
represent long-term population recovery and production rates for a given population and harvest
scenario.

During each time step (year) of model simulation, the following actions occur on the model
interface: (1) the time display advances 1 year; (2) trees grow in size on the landscape (trees are
sized according to diameter); (3) trees are logged and removed from the landscape at specified
harvest intervals; (4) trees die and are removed from the landscape; (5) the landscape
experiences disturbance (red circles = disturbance; dark red = zone of recruitment); (6) trees
reproduce and new seedlings are added to the landscape; and (7) disturbances are removed from
the landscape and the plots and monitors are updated.
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2 MANUAL GUIDE

This User Manual is intended for both beginning and advanced users working with the Big-Leaf
Mahogany Growth & Yield Model to inform management decisions. The Manual can be read
from front to back for a thorough understanding of how the model works. It can also be queried
with specific questions using the section guide below.

MODEL INSTALLATION (section 3) details the model installation process. @ HELP
BUTTONS (section 4) explains where to find help while working in the model interface. A
BRIEF GUIDE (section 5) provides basic instructions for navigating the model interface.

USER DATA UPLOAD (section 9) provides instructions for uploading user data into the model
framework. SIMULATION EXPERIMENTS (section 11) provides directions for running
repeat simulations of a single harvest regime or multiple simulations of varied harvest regimes.

ADVANCED USERS / NETLOGO RESOURCES (section 12) reviews the advanced NetLogo
features and identifies resources for interested users to learn more about NetLogo programming.

The remaining sections review model features in greater detail and can be read in advance or

when specific questions arise. If you still have questions after reading this User Manual, or have
any feedback on the model, please contact the authors (page 47).

3 MODEL INSTALLATION

3.1 CD Installation

The following section explains how to install the NetLogo software from the Big-Leaf
Mahogany Growth & Yield Model CD-ROM and how to run the model using this software.

Step 1. Insert CD into CD Drive

Insert the Big-Leaf Mahogany Growth & Yield Model CD-ROM into your computer CD drive.
If the computer does not open the CD folder within a few minutes, access the CD folder from My
Computer on a Windows computer or from the Desktop on a Mac OS X computer.

Step 2. View CD Contents

If you successfully open the CD folder, you will see the Model folder. This folder contains all

the files necessary to install the NetLogo software and run the growth & yield model. Double-
click the Model folder to view its contents. It contains six elements:

(1) Growth & Yield Model file (4) User folder
(2) User Manual file (5) Results folder
(3) Data folder (6) NetLogo folder
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The Growth & Yield Model file is the NetLogo file (.nlogo) containing the growth & yield
model. This file will only run after installing the NetLogo software.

The User Manual file is a copy of this User Manual in PDF format.

The Data folder contains all the data files necessary to run the growth & yield model. Changes
to these files may render the model inoperable. DO NOT CHANGE THEM!

The User folder contains example user upload files. These files should be viewed as templates
when uploading your own data into the model framework. You will also place your data files in
this folder when uploading your own data (section 9).

The Results folder is the default destination for certain BehaviorSpace simulation results and a
recommended destination for all other results exports.

The NetLogo folder contains the NetLogo 4.1.2 installers necessary for setting up the growth &
yield model on your computer. This folder also contains the NetLogo 4.1.2 User Manual written
by the NetLogo design team.

Step 3. Choose a NetLogo 4.1.2 Installer

Double-click on the NetLogo folder to view its contents. If you are using a Windows computer,
double-click the Windows folder, and then double-click the NetLogo4.1.2Installer.exe installer
file. If you are using a Mac OS X computer, double-click the MAC OS X folder, and then
double-click the NetLogo 4.1.2.dmg installer file.

The installer file will open when double-clicked. Follow the installation instructions to install
NetLogo software on your computer. INSTALL NETLOGO ON YOUR COMPUTER AND
NOT ON THE GROWTH & YIELD MODEL CD-ROM.

If you would prefer to download the NetLogo software from the NetLogo website, download
NetLogo 4.1.2 here: http://ccl.northwestern.edu/netlogo/4.1.2/

DO NOT USE ANY OTHER VERSION OF NETLOGO. THE MODEL ONLY WORKS IN
NETLOGO 4.1.2. Refer to the NetLogo User Manual if you require additional assistance.

Step 4. Move Model Files to Computer

If you have successfully installed the NetLogo 4.1.2 software, you are ready to open the Growth
& Yield Model file. We recommend that you copy the files from the CD onto your computer.
Copy the Models folder and paste it anywhere on your computer. Double-click the Growth &
Yield Model file to begin using the growth & yield model on your computer.

If you use Mac OS X, a blank NetLogo file may open instead of the Growth & Yield Model file.
This is a known Mac OS X — NetLogo bug and may commonly occur on your computer. It is
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easily resolved: simply leave the blank NetLogo file open and double-click the Growth & Yield
Model file again. This will always open the Growth & Yield Model file correctly.

3.2 Web Installation

The following section explains how to install the NetLogo software from the Big-Leaf
Mahogany Growth & Yield Model website and how to run the model using the software.

Step 1. Download Model Package from Website

Please visit our website to download the most recent version of the growth & yield model and to
learn more about our research: http://www.swietking.org

The model can be downloaded from THE MODEL page on the website or from the QUICK
LINKS section on every page on the site (the location of the download file is subject to change
but will always be hosted somewhere on the site). Download the zip-file (Model.zip) containing
the files necessary to install the NetLogo software and run the model on your computer. The
model will be downloaded to your default download location. To specify a different download
location, right-click on the link and select the Download Linked File As option.

Step 2. Unzip Model Package Contents

The contents of the Model.zip zip-file must be unzipped using built-in zip software. On most
operating systems, double-clicking the zip-file accesses the zip software. However, some
systems may require you to right-click the Model zip file and select the ‘unzip’ or ‘uncompress’
options. Follow the unzip instructions of your software and extract the Model folder anywhere
on your computer.

Step 3. View the Model Folder Contents
If you successfully unzip the Model.zip zip-file, you will see the Model folder. This folder

contains all the files necessary to install the NetLogo software and run the growth & yield model.
Double-click the Model folder to view its contents. It contains six elements:

(1) Growth & Yield Model file (4) User folder
(2) User Manual file (5) Results folder
(3) Data folder (6) NetLogo folder

The Growth & Yield Model file is the NetLogo file (.nlogo) containing the growth & yield
model. This file will only run after installing the NetLogo software.

The User Manual file is a copy of this User Manual in PDF format.

The Data folder contains all the data files necessary to run the growth & yield model. NEVER
ALTER OR REMOVE ANY FILES IN THIS FOLDER.
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The User folder contains example user upload files. These files should be viewed as templates
when uploading your own data into the model framework. You will also place your data files in
this folder when uploading your own data (section 9).

The Results folder is the default destination for certain BehaviorSpace simulation results and a
recommended destination for all other results exports.

The NetLogo folder contains the NetLogo 4.1.2 installers necessary for setting up the growth &
yield model on your computer. This folder also contains the NetLogo 4.1.2 User Manual written
by the NetLogo design team.

Step 4. Choose a NetLogo 4.1.2 Installer

Double-click on the NetLogo folder to view its contents. If you are using a Windows computer,
double-click the Windows folder, and then double-click the NetLogo4.1.2Installer.exe installer
file. If you are using a Mac OS X computer, double-click the MAC OS X folder, and then
double-click the NetLogo 4.1.2.dmg installer file.

The installer file will open when double-clicked. Follow the installation instructions to install
NetLogo software on your computer.

If you would prefer to download the NetLogo software from the NetLogo website, download
NetLogo 4.1.2 here: http://ccl.northwestern.edu/netlogo/4.1.2/

DO NOT USE ANY OTHER VERSION OF NETLOGO. THE MODEL ONLY WORKS IN
NETLOGO 4.1.2. Refer to the NetLogo User Manual if you require additional assistance.

Step 5. Open Model NetLogo File

If you have successfully installed the NetLogo 4.1.2 software on your computer, you are ready to
open the Growth & Yield Model file. Double-click the Growth & Yield Model file to begin using
the growth & yield model on your computer.

If you use Mac OS X, a blank NetLogo file may open instead of the Growth & Yield Model file.
This is a known Mac OS X — NetLogo bug and may commonly occur on your computer. It is
easily resolved: simply leave the blank NetLogo file open and double-click the Growth & Yield
Model file again. This will always open the Growth & Yield Model file correctly.

3.3 Online Model

The online version of the Big-Leaf Mahogany Growth & Yield model can be accessed from the
following website: http://www.swietking.org. The online model is identical to the computer
model except that it cannot: (1) upload user data files; (2) export simulation results; (3) run
BehaviorSpace experiments; (4) accommodate Command Line queries; and (5) resize the
model landscape elegantly.
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The online version of the model cannot upload user data or export simulations because of the
limitations of our web server. Additionally, the online version of the model cannot display the
stream and boundary data exhibited in the computer model because the NetLogo GIS extension
is currently incompatible with the online applets. Finally, the online version of the model only
simulates the SE Para (204 ha) population because of unidentified programming complications.

BehaviorSpace experiments and Command Line queries can only be accommodated by
installing and running NetLogo on your computer. The online applet only runs the features
maintained on the model interface. It does not support any NetLogo features occurring outside
this interface.

The interface landscape can be resized in the online version of the model but this feature is more
difficult to manipulate online than on your computer. The online model will not resize the
landscape to a new Patch-Area if the blinking mouse-cursor is still in the Patch-Area input.
Click anywhere within the online interface to remove the blinking mouse-cursor from the input
(clicking in another input is an effective strategy) and click Resize to resize the model landscape.

These issues will be resolved if possible. Please sign up to receive updates on the model and our
research on our website: http://www.swietking.org

Java Versions

The Big-Leaf Mahogany Growth & Yield Model applet requires that your web browser support
Java 5 or higher. The correct version of Java can be obtained following these directions:

*  Windows users (Vista, XP, or 2000) can download the Java browser plug-in from here:
http://www.java.com/en/download/windows_manual.jsp

*  Mac OS X users require version 10.4 or higher. No plug-in is necessary.

* Linux and Unix system users need the Sun Java Runtime Environment Version 5 or
higher. This is available for download here: http://www.java.com/. Check your
browser's homepage for more information on installing the Java plug-in.

If you think you have the right browser and plug-in but the online model still does not work,
check your browser's preferences to ensure that Java is enabled.

The following web site may be helpful for determining which version of Java you have and for
getting the correct version installed and running: http://www.javatester.org/

Browser Memory
The Big-Leaf Mahogany Growth & Yield Model applet may require more memory than the
browser normally makes available. This is more likely to happen when simulating large

populations.

On Windows, you can increase the available memory (‘heap’) space in the Java Control Panel's
applet runtime settings. In the Java tab of the Java Control Panel, view the Java Applet Runtime

10
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Settings. Enter the following in the Java Runtime Parameters field: -Xmx1024M. Include the
initial hyphen (‘-”) but not the final period (‘.”). More information is available here:

http://download.oracle.com/javase/1.5.0/docs/guide/deployment/deployment-guide/jcp.html

Mac OS X 10.4 users should note that Mac OS X 10.4 initially had a low memory limit for Java
applets (~64 megabytes). A Java update from Apple raised the memory limit to 96 megabytes.
This update is available through the Sofiware Update but no other options for increasing the Java
memory limit are available.

4 HELP BUTTONS ? 1

Pressing HELP buttons (?), located on the right side of each model interface section, allows you
to see definitions of model features in the DEFINITIONS box (see below). Each model section
can be queried in this way.

To see definitions of all model features without pressing each ? button, press the All Definitions
button located below the DEFINITIONS box. In addition, definitions are listed in APPENDIX
B: MODEL DETAILS & DEFINITIONS of this Manual.

You can also look for help by selecting Help in the NetLogo menu bar. The Search option can
direct you to specific menu items or help topics. The Look Up In Dictionary (F1) option opens
a web browser with the dictionary entry for the selected code. The NetLogo User Manual and
NetLogo Dictionary links will open the manual and dictionary in a web browser. The NetLogo
Users Group option will link you to the NetLogo Users Group, also in a web browser.

DEFINITIONS This is the DEFINITIONS box as it appears on the
Prass Hm s Suttan et fx sach sackimm o v model interface. Feature definitions can be viewed by
features in this definition box. Press 'All De )
of all the sections. using the blue bar to scroll across the text content.

All definitions can be accessed by pressing A on the
keyboard. This is the shortcut for the All Definitions
button.

Button shortcuts are displayed in the upper-right corners
of the buttons. E is the shortcut for the Export Results
button, S is the shortcut for the Setup button, D is the
shortcut for the Defaults button, etc.

A button shortcut will appear black when enabled and

o —— — — B T gray when disabled. To enable shortcuts, click
=T : anywhere in the white background of the model
All Definitions Export Results ? interface.

Additional questions can be directed to the authors listed at the end of the Manual (page 47).

11
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The following guide describes the most basic method for simulating a pre-defined big-leaf

mahogany population.

Step 1. Designate Initial Population to Simulate

Populations
SE Pard (204ha) v

Step 2. Set Simulation Time Limit

e e
Time 100 Years

Select either a pre-defined example population or upload your own data
using one of the USER DATA UPLOAD options (section 9).

A simulation will end when the time limit is reached or when all the
trees are harvested or die. Adjust the time limit by using your computer
cursor to slide the red bar horizontally across the dark green slider.

Movements to the right increase the parameter values while movements to the left decrease the

parameter values.

Step 3. Set Logging Parameters

135 tesong
m

Defaults

Step 4. Setup Initial Population

Setup

To simulate the population with a harvest regime, select logging ‘on’,
otherwise select logging ‘oft”. If logging:

Set a minimum diameter cutting limit
(default = 60 cm diameter).

Set a commercial tree retention rate
(default = 20% commercial retention).

Set

minimum  post-harvest commercial

population density (default = 5 trees / 100 ha).

Set a cutting cycle length (default = 30 years).

12

D| Default harvest parameters can be restored using the Defaults button in the upper
left-hand corner of the model interface.
settings. Default conditions are reviewed below (sections 6.2 & 7).

This button also restores default model

S| Establish the initial population on the landscape. The population will appear on the
model interface in the ‘landscape’ (middle) field. The landscape population can be
resized using the Patch-Area input and the Resize button (section 6.1).
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Step 5. Begin Simulations

1| Run the simulation for a single year. This feature is useful when
Run 1 Year carefully monitoring a simulation or when troubleshooting.

Run the simulation until the time limit is reached, or until all trees are
Run X Years | harvested or die, if this occurs before reaching the time limit.

Step 6. Monitor Simulations

Year 0 Population and Current Population monitors report total tree density (trees > 20 cm
diameter / 100 ha), commercial-sized tree density (commercial trees / 100 ha = default value),
and commercial-sized tree volume (m®) during Year 0 and the Current simulation year.

Diameter Distribution Tree Abundance
50 250
3 = ?
o —
3 o
. %
0 o—""1+—
0 Size Class 200 0 Time (yrs) 150

Current Population plots show changes in tree size-class distribution and abundance over time.
These plots are updated each year according to simulation results.

The Diameter Distribution plot shows the initial size-class distribution in black and the
current-year size-class distribution in red. The vertical gray line divides non-commercial and
commercial trees.

The Tree Abundance plot shows the abundance of all trees > 20 cm diameter in black and the
abundance of commercial-sized trees in red. The vertical gray lines indicate the harvest years,
that is, 31, 61, and 91 years in the example shown.

Harvest Productivity monitors report the volume of trees logged in the most recent harvest as
well as the number and volume of trees logged in all previous harvests. Monitors are updated
after each logging event. Logged Volume reports the volume (m’) of trees logged in the most
recent harvest. Total Logged Volume reports the volume (m’) of trees logged in all previous
harvests. Total # Logged Trees reports the number of trees logged in all previous harvests.

Step 7. Export Simulation Results

E! Export the simulation results to a text (.txt) file on your computer.
Export Results Results describe initial and final populations and harvest productivity.

13
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6 MODEL SETTINGS

The MODEL SETTINGS parameters determine: (1) which population is simulated during
model runs; (2) whether logging is performed; and (3) how long the simulation is run. The
MODEL SETTINGS buttons set up the initial population, re-set parameters to default
conditions, and begin model simulations. The area (in hectares, or ha) of the field site is also
displayed in this section.

MODEL SETTINGS , ,
S D Populations Site Area (ha)
Setup | Defaults | | Sg pars (204ha) il 2128
?
—= , : =T -
’]‘8% Logging | Time 100 Years Run 1 Year ‘ Run X Years o

6.1 Setup & Resize Initial Population

The Setup button establishes the initial population on the model landscape shown across the
center of the model interface. The population displayed on the landscape is selected from the
Populations menu, which lists three pre-defined example populations and three user-defined
population upload options.

The example populations are based on mahogany population and spatial data from study sites in
southeast Para and Acre. The user populations represent the three methods for uploading user
data into the model. The six population options are summarized below. User populations are
discussed in greater depth in USER DATA UPLOAD (section 9).

EXAMPLE POPULATIONS

SE Para (204 ha): 204-ha field site with 143 trees
SE Para (1035 ha): 1035-ha field site with 745 trees
Acre/West Amazon: 685-ha field site with 81 trees

SE Para (204 ha) and SE Para (1035 ha) present spatial and diameter data for mahogany
populations in southeast Para, Brazil. The forest management and long-term research site, called
Marajoara, is located 34 km northwest of Redencdo. Marajoara was selectively logged for
mahogany during 1992-1994. The population in 204 ha is from a 100% inventory for mahogany
trees > 20 cm diameter. The population in 1035 ha contains the 204-ha population but at lower
sampling resolution, representing > 80% of trees > 20 cm diameter in this larger forest area.
Most of the trees presented here are logged stumps. For more details see Grogan et al.
references (section 16).

Acre/West Amazon presents spatial and diameter data for a mahogany population located 40

km south of Sena Madureira in the western Brazilian state of Acre. This data is from a 100%
inventory in 685 ha for mahogany trees > 20 cm diameter. At the time of inventory this was an

14
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unlogged population. The low landscape-scale density is typical of western Amazonian
mahogany populations.

USER POPULATIONS

User Population (xyd): For uploading spatial and diameter data from a spreadsheet.
User Population (shp): For uploading spatial and diameter data from a shapefile.
User Population (csv): For uploading non-spatial diameter data from a spreadsheet.

The site is drawn in the ‘landscape’ (middle) field of the model interface. If the site is drawn too
small for the available space, increase the value shown in Patch-Area and press the Resize
button (upper-right on interface). If the site is drawn too large for the available space, decrease
the value shown in Patch-Area and press the Resize button. Continue to make adjustments by
increasing or decreasing the Patch-Area until you are satisfied with the size of your site on the
interface. See section 9.1 Step 4 for more details.

6.2 Setup & Run Simulations

The Logging and Time parameters determine how the model will simulate the initial population.
The Logging switch determines whether the population is simulated with or without logging.
Select On to run simulations with logging. Select Off to run simulations without logging.

The Time slider determines how long the simulation will run. The model will simulate the
growth and harvest of the initial population until the time limit is reached or until all trees are
harvested or die, whichever happens first. Population growth and harvests can be simulated up
to 150 years. Changes to the simulation length can be made in 5-year increments.

The Run 1 Year button runs the model for a single year. The Run X Years button runs the
model until the time limit is reached or until all trees are harvested or die, whichever happens
first.

The Defaults button returns all variables to default conditions:

Populations: SE Para 1 (204 ha) Logging: On
Patch-Area: 2.75 pixels Time: 100 years

7 LOGGING PARAMETERS

The default harvest parameters are set according to the current Brazilian forest management
regulations for mahogany. These regulations mandate a minimum diameter cutting limit of > 60
cm, the retention of > 20% of commercial-sized trees, the prohibition of logging in areas with
population densities < 0.05 trees ha™ (5 commercial trees / 100 ha), and a cutting cycle of 25-30
years.

15
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LOCCING PARAMETERS

minimum-diameter 60 cm retention-rate 20 % trees

?
| | || | | — '
minimum-density S trees/100ha | cutting-cycle 30 years

Harvest parameters can be changed according to user preference. Each parameter can be reset
using the computer cursor to move the red bar across the green slider. Movements to the right
increase the parameter values while movements to the left decrease the parameter values. The
minimum value, maximum value, and value increment are listed for each parameter below:

Minimum Diameter: 0 — 100 cm; 5 cm increments

Retention Rate: 0 — 100 % retention; 5% retention increments
Minimum Density: 0 —20 trees / 100 ha; 1 tree / 100 ha increments
Cutting Cycle: 0 — 100 years; 5-year increments

Pressing the Defaults button will return the logging parameters to default conditions.

Minimum Diameter: 60 cm Minimum Retention: 20% trees
Minimum Density: 5 trees / 100 ha Cutting Cycle: 30 years

If you do not want to simulate logging, turn logging off using the Logging switch discussed
above.

8 SIMULATION RESULTS

The model interface provides information to allow users to observe simulations as they progress.
8.1 Population Monitors

The YEAR 0 POPULATION and CURRENT POPULATION monitors report total tree
density, commercial tree density, and commercial tree volume during year 0 and the current
simulation year, respectively. YEAR 0 POPULATION monitors are static, while CURRENT
POPULATION monitors are updated each year according to simulation results.

YEAR 0 POPULATION
Total Density (#/100ha) || Commercial Density (#/100ha) || Commercial Volume (m3)
67.2 40.9 546.4
CURRENT POPULATION
Total Density (#/100ha) || Commercial Density (#/100ha) || Commercial Volume (m3)
27.3 5.6 87.5
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Density monitors report tree density as the number of trees per 100 hectares. Density can be
converted to abundance using the following equation:
Abundance = Density * Area / 100

where density (trees / 100 ha) is either total or commercial density and area (ha) is the Site Area,
as reported in the upper-right portion of the MODEL SETTINGS section of the model

interface.

Volume monitors report volume in cubic meters (m*). Volume is calculated from the diameter
of each tree according to the equation:

Volume (m’) = 0.056 — (0.01421 * Diameter) + (0.001036 * Diameter’2)

where tree diameters (cm) are measured 1.3 m above the forest floor or at least 30 cm above the
reach of the tallest buttress (Mayhew & Newton 1998, p. 117).

8.2 Population Plots

The CURRENT POPULATION plots show changes in tree size-class distribution and
abundance over time. These plots are updated each year according to simulation results.

Diameter Distribution Tree Abundance
50 250
g = ?
o ——
E o
(' %
0 o—""1+—
0 Size Class 200 0 Time (yrs) 150

The Diameter Distribution plot shows the initial size-class distribution in black. This
distribution is static. The current-year size-class distribution is shown in red. This distribution
updates each year according to simulation results. The diameter size classes are defined by 10-
cm intervals and only trees > 20 cm diameter are plotted. The vertical gray line divides
commercial and non-commercial trees as determined by the minimum diameter cutting limit.

The Tree Abundance plot shows the abundance of trees over time. The black line tracks the
abundance of all trees > 20 cm diameter. The red line tracks the abundance of commercial-sized
trees. The vertical gray lines indicate the harvest years, that is, 31, 61, and 91 years in the
example shown.
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8.3 Harvest Productivity Monitors

HARVEST PRODUCTIVITY monitors report the volume of trees logged in the most recent
harvest as well as the number and volume of trees logged in all previous harvests. Monitors are
updated after each logging event.

HARVEST PRODUCTIVITY , ,
Logged Volume {m3) Total Logged Volume (m3) Total # Logged Trees
48.6 590.9 96 ?

Logged Volume reports the volume (m?) of trees logged in the most recent harvest.
Total Logged Volume reports the volume (m’) of trees logged in all previous harvests.
Total # Logged Trees reports the number of trees logged in all previous harvests.

9 USER DATA UPLOAD

You can simulate population growth and harvest outcomes of a mahogany population at your
own site using the DATA UPLOAD portion of the model interface. At minimum you will need
diameter data for the trees within your site.

If you have both spatial distribution (mapping) and tree diameter data, you can upload the data
from a spreadsheet or, if available, from a GIS shapefile. Refer below to Spatial Diameter Data:
User Spreadsheet and Spatial Diameter Data: User Shapefile (sections 9.1 & 9.2), respectively,
for instructions.

If you only have diameter data, you can upload the data from a spreadsheet, but you will need to
know or estimate the dimensions or approximate area of your site. Refer to Non-Spatial
Diameter Data: User Spreadsheet (section 9.3) below.

9.1 Spatial Diameter Data: User Spreadsheet

This section describes the procedures necessary to upload diameter data with spatial location
information from a user spreadsheet. The spatial diameter data must be formatted according to
the instructions below for the model to accept the user data.

Step 1. Data Structure and Format

The first step is to structure your data so the computer can read the information into the model.
Create an Excel (.xIs)-type spreadsheet to organize the data into three columns: X-coordinates,
Y-coordinates, and tree diameters. The columns must be listed in this order for your data to be

read into the model.

Column A should contain the X-coordinates (longitude) of each tree. Column B should contain
the Y-coordinates (latitude) of each tree. Column C should contain the diameter in centimeters
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of each tree. DO NOT GIVE THE COLUMNS HEADERS. The head of your file should look
like the example file shown on the next page.

The XY coordinates (longitude/latitude) must be measured in either meters or decimal degrees.
In the example above, coordinates are given in UTM (Universal Transverse Mercator)
geographic coordinate units taken from a standard GPS unit. Alternatively, coordinates could be
given in user-assigned meter units derived from a field-based inventory.

Coordinates cannot be given in degrees, minutes, and seconds. Coordinates measured in this
format can be converted here: http://www.fcc.gov/mb/audio/bickel/DDDMMSS-decimal.html.

X-Coordinates Y-Coordinates Diameters

\ A A
< Lo B C D
1 579775.8 9136498.4 71.3
2 5797448 9136501.6 79.4
3 580177.6 9135822.6 66.1
o 580265.1 9135770.8 80.4
Trees 5 580300.9 9135752.5 45.5
6 580317.3 9135686.3 64.7
7 580343.1 9135666.1 72.5
8 580406.1 9135441.5 79.0

Diameters must be measured in centimeters (cm). Tree diameter measurements should be taken
at 1.3 m above the forest floor or at least 30 cm above the reach of the tallest buttress.

Step 2. Save As Text File

The model software cannot read data from Excel (.xls) files so the data must be saved as a text
(.txt) file. In Excel, or a similar spreadsheet program, choose File > Save As and select Text (tab
delimited) from the Save As options. Include the .zxt extension in the file name. The head of the
new text file should look like this, WITHOUT COLUMNS HEADERS:

X-Coordinates Y-Coordinates Diameters
v v v
579775.8 9136495 .4 71.3
579744.8 9136561 .6 79.4
588177.6 9136822.6 66.1
E86265.1 9135770.8 86.4
Trees 580308.9 9135752.5 45.5
588317.3 9135686.3 64.7
586343.1 9135666.1 72.5
F88406.1 9135441.5 79
E2nd?a 7 Q12E4GE 2 a1 2

Place the new text file in the Model > User folder. Remember the name of the new text file.
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Step 3. NetLogo File Parameters

The final steps towards uploading your data into the model are completed in the DATA
UPLOAD portion of the model interface. These parameters specify the name of the user data
file, the dimensions of the user field site, and the resolution of the resulting landscape.

DATA UPLOAD

File-Name

mara-204-tree-data.txt

?
DIAM-Attribute-Name

Site-Width Site-Height Patch-Area

1216.1 1712.4 1 Resize

Type the name of the text file from Step 2 containing spatial and diameter data (located in the

User folder) into the File-Name input box. Be sure to include the ‘.txt’ file extension when
typing the name.

Leave the DIAM-Attribute-Name input blank. This input is only necessary for data uploaded
from a user shapefile (section 9.2). Input here will interfere with the present upload.

Type the width (X, in meters) of your site into the Site-Width input box and the height (Y, in
meters) of your site into the Site-Height input box. If your site is not rectangular, estimate the
width and height of the smallest bounding rectangle (examples shown below). Again, the width
and height of your site must be in meters (m).

Width

-

Height
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Type the value 1.00 into the Patch-Area input box. Patch-Area determines the size of
landscape patches in pixels and therefore determines the size of the landscape. A Patch-Area of
1.00 is purposefully small and should draw a landscape contained by the available space on the
model interface.

Step 4. Resize Site Drawing

After File-Name, Site-Width, Site-Height, and Patch-Area have been specified, press the
Setup button under MODEL SETTINGS to draw your site on the model interface. If the site
dimensions are incorrect, ensure that the file is formatted correctly (columns: X-coordinate, Y-
coordinate, diameter). If you receive an error message, refer to Error Messages / Trouble
Shooting (section 9.4) below.

The site should be drawn using a Patch-Area of 1.00 pixel but a larger or smaller Patch-Area
may be preferred depending on the dimensions of your site. If the site is drawn too small for the
available space, increase the Patch-Area by entering 2.00 and press the Resize button. If the
site is drawn too large for the available space, decrease the Patch-Area by entering 0.50 and
press the Resize button. Continue to make adjustments by increasing or decreasing the Patch-
Area until you are satisfied with the size of your site projected onto the model interface.

Step 5. Trouble Shooting
If you require quick assistance, press the ? button for a summary of the DATA UPLOAD

features or refer to this manual. See Error Messages / Trouble Shooting (section 9.4) below for
a discussion of error messages you may encounter when uploading your data into the model.

9.2 Spatial Diameter Data: User Shapefile

This section describes the procedures necessary to upload your data from a GIS shapefile. A
shapefile is a file type produced by GIS software to store location and attribute data. This user
data upload feature will not support any other geospatial file format.

Step 1. Place Shapefile in User Folder

Place the shapefile containing spatial diameter data of your tree population in the Model > User
folder. Place the dbf file (.dbf) associated with the shapefile here as well (the .prj, .sbn, .sbx,
.shx, and .xml files are not necessary). Remember the name of the overarching shapefile (.shp).
Step 2. NetLogo File Parameters

Parameters in the DATA UPLOAD portion of the model interface specify the name of the user
data file, the name of the diameter attribute, the dimensions of the field site, and the resolution of

the landscape (shown on the next page).

Type the name of the shapefile from Step 1 containing spatial and diameter data (located in the
User folder) in the File-Name input box. Include the .shp’ file extension when typing the name.
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Type the name of the attribute (data column header) in the shapefile containing the diameter data
in the DIAM-Attribute-Name input box. The diameters listed in the shapefile must be
measured in centimeters (cm). Tree diameter measurements should be taken at 1.3 m above the
forest floor or at least 30 cm above the reach of the tallest buttress.

DATA UPLOAD

File-Name

—mara-204-tree-data.shp

?
DIAM-Attribute-Name
DIAM2004
Site-Width Site-Height Patch-Area
Resize

1216.1 dl1712.4 JIi1

Type the width (X, in meters) of your site into the Site-Width input box and the height (Y, in
meters) of your site into the Site-Height input box. If your site is not rectangular, estimate the
width and height of the smallest bounding rectangle (examples shown above). Again, the width
and height of your site must be in meters (m).

Type the value 1.00 into the Patch-Area input box. Patch-Area determines the size of
landscape patches in pixels and therefore determines the size of the landscape. A Patch-Area of
1.00 is purposefully small and should draw a landscape contained by the available space on the
model interface.

Step 3. Resize Site Drawing

After File-Name, DIAM-Attribute-Name, Site-Width, Site-Height, and Patch-Area have
been specified, press the Setup button under MODEL SETTINGS to draw your site on the
model interface. The site should be drawn using a Patch-Area of 1.00 pixel but a larger or
smaller Patch-Area may be preferred depending on the dimensions of your site.

If the site is drawn too small for the available space, increase the Patch-Area by entering 2.00
and press the Resize button. If the site is drawn too large for the available space, decrease the
Patch-Area by entering 0.50 and press the Resize button. Continue to make adjustments by
increasing or decreasing the Patch-Area until you are satisfied with the size of your site on the
model interface.

Step 4. Trouble Shooting
If you require quick assistance, press the ? button for a summary of the DATA UPLOAD

features or refer to this manual. See Error Messages / Trouble Shooting (section 9.4) below for
a discussion of error messages you may encounter when uploading your data into the model.
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9.3 Non-Spatial Diameter Data: User Spreadsheet

This section describes the procedures necessary to upload diameter data without spatial location
information into the model interface. Although spatial diameter data is not required for this data
upload feature, you must know or estimate the physical dimensions or area (ha) of your field site.

Step 1. Data Structure and Format

The first step is to structure your data so the computer can read the information into the model.
Create a spreadsheet to organize the data into a single column: tree diameter (cm). DO NOT
GIVE THE COLUMN A HEADER. The head of your file should look like this:

Diameters

\

A B

71.3
79.4
66.1
80.4
45.5
64.7
72.5

79

A1 N

Dw\'mthNHO

Trees

Diameters must be measured in centimeters (cm). Tree diameter measurements should be taken
at 1.3 m above the forest floor or at least 30 cm above the reach of the tallest buttress.

Step 2. Save As CSV File

The modal software cannot read data from Excel (.xIs) or similar files, so the data must be saved
as a comma separated value (.csv) file. Choose File > Save As and select CSV (comma
delimited) from the Save As options. INCLUDE THE ‘.CSV’ EXTENSION IN THE FILE
NAME.

Place the new .csv file in the Model > User folder. Remember the name of the .csv file.

Step 3. NetLogo File Parameters

The final steps towards uploading your data into the model are completed in the DATA
UPLOAD portion of the model interface. These parameters specify the name of the user data

file, the dimensions of the user field site, and the resolution of the resulting landscape.

Type the name of the .csv file from Step 2 containing diameter data (located in the User folder)
into the File-Name input box. Be sure to include the ‘.csv’ file extension when typing the name.
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DATA UPLOAD

File-Name

mara-204-tree-data.csv

DIAM-Attribute-Name

Site-Width Site-Height Patch-Area

1216.1 dl1712.4 JIi1 Resize

Leave the DIAM-Attribute-Name input blank. This input is only necessary for data uploaded
from a user shapefile (section 9.2). Input here will interfere with the present upload.

Type the width (X, in meters) of your site into the Site-Width input box and the height (Y, in
meters) of your site into the Site-Height input box. If your site is not rectangular, estimate the
width and height of the smallest bounding rectangle (examples shown above). Again, the width
and height of your site must be in meters (m).

Type the value 1.00 into the Patch-Area input box. Patch-Area determines the size of
landscape patches in pixels and therefore determines the size of the landscape. A Patch-Area of
1.00 is purposefully small and should draw a landscape contained by the available space on the
model interface.

Step 4. Resize Site Drawing

After File-Name, Site-Width, Site-Height, and Patch-Area have been specified, press the
Setup button under MODEL SETTINGS to draw your site on the model interface. The site
should be drawn using a Patch-Area of 1.00 pixel but a larger or smaller Patch-Area may be
preferred depending on the dimensions of your site.

If the site is drawn too small for the available space, increase the Patch-Area by entering 2.00
and press the Resize button. If the site is drawn too large for the available space, decrease the
Patch-Area by entering 0.50 and press the Resize button. Continue to make adjustments by
increasing or decreasing the Patch-Area until you are satisfied with the size of your site on the
model interface.

Step 5. Trouble Shooting
If you require quick assistance, press the ? button for a summary of the DATA UPLOAD

features or refer to this manual. See Error Messages / Trouble Shooting (section 9.4) below for
a discussion of error messages you may encounter when uploading your data into the model.
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9.4 Error Messages & Trouble Shooting

If an error occurs while uploading your data, the model will stop the uploading process and
present a message explaining the cause of the error. The following is a list of potential error
messages and possible solutions.

A 'Population' must be selected. You selected the blank population option. Please select an
actual population to simulate.

An 'Example Population' must be selected. You selected the Example Population heading.
Please select an actual example population to simulate.

A 'User Population' must be selected. You selected the User Population heading. Please
select an actual user population to simulate.

A 'File-Name' must be specified. You selected a User Population but did not specify a user
data file. Please provide the name of the user data file or choose an example population.

'File-Name' must be a .txt file. You selected the User Population (xyd) option, which requires
a user text file, but the file specified in File-Name does not have a .txt extension. Please ensure
the file is a text file and has the text file extension (.txt).

'File-Name' must be a .shp file. You selected the User Population (shp) option, which
requires a user shapefile, but the file specified in File-Name does not have a .shp extension.
Please ensure the file is a shapefile and has the shapefile extension (.shp).

A 'DIAM-Attribute-Name' must be specified. You selected the User Population (shp)
option, which requires a DIAM-Attribute-Name, but the DIAM-Attribute-Name field is
empty. Please provide the name of the shapefile diameter attribute in this field.

'File-Name' must be a .csv file. You selected the User Population (csv) option, which requires
a user csv file, but the file specified in File-Name does not have a .csv extension. Please ensure
the file is a csv file and has the csv file extension (.csv).

'Site-Width' must be a positive non-zero number. You provided a non-zero (negative or zero)
site width. Please provide a positive site width measured in meters (m).

'Site-Height' must be a positive non-zero number. You provided a non-zero (negative or
zero) site height. Please provide a positive site height measured in meters (m).

'Patch-Area' must be a positive non-zero number. You provided a non-zero (negative or
zero) patch area. Please provide a positive patch area measured in meters (m).

The site cannot be set up. Please review the file formatting / placement guidelines. You

most likely received this error because the data file is formatted incorrectly or is not located in
the Model > User folder. The data file should be placed in the User folder and should not have
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any headers, commas, spaces, or other symbols. Review this manual to ensure proper
formatting.

9.5 User Data Upload Examples

There are example user files in the Model > User folder to help illustrate the user data upload
process. The folder contains the files necessary to set up the SE Para (204ha) population using
each of the three user data upload methodologies.

The files and inputs required for each methodology are listed below. If you have any questions
about formatting, look to these files as templates. If you have questions about the inputs, look to
the information below and the DATA UPLOAD figures presented above (sections 9.1, 9.2 &
9.3).

Data DIAM- Site- Site- Patch-
Upload Type File-Name Attribute-Name Width Height Area
Spatial: TXT File mara-204-tree-data.txt 1216.1 17124 1.0
Spatial: SHP File mara-204-tree-data.shp* DIAM2004 1216.1 17124 1.0

Non-Spatial: CSV

File mara-204-tree-data.csv 1216.1 17124 1.0

*The .dbf file is associated with this shapefile and is necessary for data upload using this method.

10 EXPORT SIMULATION RESULTS Export Results

The monitors, plots, and landscape features provide a means for observing simulation results in
real-time, but these results are not stored in memory or elegantly summarized for the user.
Simulation end results can be permanently stored and easily reviewed by pressing the Export
Results button. The resulting file summarizes a given simulation by showing the model settings,
harvest parameters, and initial population, final population, and harvest statistics.

Simulation results must be saved as a text (.txt) file. These files can be named and placed
anywhere on your computer. It may be useful to name your file based on the simulated
parameters; for example, Marajoara-60cm-20rr-5md-30yr-1 indicates the population simulated,
while cm, rr, md, and yr indicate the simulated minimum diameter cutting limit, retention rate,
minimum density, and cutting cycle, respectively, and / indicates the simulation number.

Results text files can be opened with Notepad on Windows and TextEdit on Mac OS X. If you
are missing either of these programs (they come preinstalled on your computer), free alternatives
are available online. For Windows users, Another Notepad is a simple and free text editor:
http://www.pc-shareware.com/anotepad.htm. For Mac users, Plain Text Editor is also a simple
and free text editor: http://www.macupdate.com/app/mac/8724/plain-text-editor.

26



Free Landis & Grogan, Mahogany Growth & Yield

SIMULATION RESULTS, the head of the Results file, summarizes the model settings used in
the completed simulation. This section lists: (1) the name of the field site (the data file name, if
running a user population); (2) the area of the field site in hectares; (3) whether logging was
turned on or off; and (4) the number of harvest cycles, the simulation time limit in years, and the
actual time run in years.

The second section of the Results file reminds the user that additional simulations are necessary
to validate the results of a single simulation. This can be achieved by repeating the same single-
run simulation or by running a BehaviorSpace experiment (section 11) as described below.

The lines following these reminders define Total Abundance/Density and Commercial
Abundance/Density as referred to in the Results file statistics. In all cases, Total
Abundance/Density refers to trees > 20 cm diameter. Commercial Abundance/Density refers to
trees > the minimum diameter cutting limit designated on the model interface.

The next section, LOGGING PARAMETERS, only appears if logging was turned on during
the simulation and reports the logging parameter values used during the simulation. If the
logging parameters are changed mid-simulation, only the end parameter values will be displayed.

YEAR 0 STATISTICS and YEAR XXX STATISTICS report the total abundance and density
and commercial abundance, density, and volume of trees in the initial and final years of the
simulation. The year value in the YEAR XXX STATISTICS heading will be the final year of
simulation, that is, a simulation lasting 100 years will read YEAR 100 STATISTICS.

The HARVEST STATISTICS section is only displayed if logging is turned on during the
simulation. This section summarizes the number of harvests, number of trees logged, and
volume of trees logged during the simulation runtime. The section also summarizes the results
of each harvest by displaying the year and productivity of successive harvest events.

Finally, the SIZE DISTRIBUTION (YEAR XXX) section summarizes the size distribution of
trees > 20 cm diameter in the final year of simulation. The largest tree is always contained
within the second largest size class, that is, the final size class will always contain O trees. The
number of size classes changes based on the size distribution of trees in the final year but the size
class increment is always 10 cm diameter.

11 SIMULATION EXPERIMENTS: BehaviorSpace

The NetLogo BehaviorSpace tool allows users to easily run repeat simulations of the Big-Leaf
Mahogany Growth & Yield Model using either constant or systematically varied harvest
parameter settings. The BehaviorSpace tool thus enables users to examine the outcomes of
multiple harvest regimes with statistical confidence (repeat simulations) and methodological ease
(automated process). Results from these simulations are then tabulated into a spreadsheet for
analysis.
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The following section explains how to run, modify, and analyze the six built-in BehaviorSpace
experiments.

Step 1. Define Model Parameters

BehaviorSpace experiments will systematically vary the harvest parameters but you must define
the other model settings before running an experiment. Define Populations, Logging, and Time
on the model interface according to the directions above (section 6.2). If you intend to simulate
one or more harvest regimes, be sure that the Logging switch is turned on.

Step 2. Open BehaviorSpace

Open the BehaviorSpace tool by selecting Tools > BehaviorSpace in the NetLogo menu. The
BehaviorSpace window will open in the center of your screen:

(< NONG) BehaviorSpace

Experiments:

Population Growth: No Logging (100 runs)

Population Growth & Productivity: Standard Logging (100 runs)
Population Growth & Productivity: Retention Experiment (600 runs)
Population Growth & Productivity: Density Experiment (1500 runs)
Population Growth & Productivity: Cutting Cycle Experiment (400 runs)
Population Growth & Productivity: Custom Logging (100 runs)

( New) ( Edit) & Duplicate) ( Delete ) Ekuna

/4

Seven built-in experiments are listed in this window. Resize the window to view the full
experiment names by grabbing the triangle in the bottom-right corner. The function of each
experiment is summarized below. The buttons in the BehaviorSpace window behave as
follows:

New creates a new BehaviorSpace experiment

Edit opens the selected BehaviorSpace experiment for editing
Duplicate duplicates the selected BehaviorSpace experiment
Delete deletes the selected BehaviorSpace experiment

Run runs the selected BehaviorSpace experiment
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Before running an experiment, you should select the Edit option and familiarize yourself with
the experiment’s settings. The modification of these settings and the creation of new
experiments are discussed more below (section 12.2).

Step 3. Choose a BehaviorSpace Experiment
Choose a baseline BehaviorSpace experiment to match your experimental goals:

The Population Growth: No Logging experiment simulates the initial population without
logging in order to examine the natural projection of the population.

The Population Growth & Productivity: Standard Logging experiment simulates the initial
population under current (default) harvest standards in order to examine the projection of the
initial population following these legal guidelines.

The four Population Growth & Productivity: Harvest Parameter experiments examine the
effect of each harvest parameter on population growth and harvest productivity by varying a
single harvest parameter and keeping the other parameters constant.

The final Population Growth & Productivity: Custom Logging experiment provides a place
for the user to define a single custom harvest regime to simulate the recovery and productivity of
the initial population under these guidelines.

Step 4. Examine & Modify a BehaviorSpace Experiment

Select the chosen baseline experiment in the BehaviorSpace window by pressing the name of
the experiment. The name should now be highlighted in blue. Press Edit to edit the details of
the experiment. The Experiment window, shown on the next page, will open in the center of
your screen.

Resize the window as needed by grabbing the triangle in the bottom-right corner. The window
displayed on the next page describes the Population Growth & Productivity: Diameter
Experiment, as listed in the Experiment name field at the top of the window.

Experiment Variables

The second field lists the variables to be examined during the BehaviorSpace simulation. In this
experiment, logging is turned permanently on (/"/logging” true]) and the minimum-diameter is
varied from 40 cm to 90 cm by increments of 10 cm (i.e., 40, 50, 60, 70, 80, 90 cm). All other
harvest parameters and model settings will remain constant based on the current interface
settings.

The variables section has a similar structure in each experiment. Population Growth: No

Logging is the only experiment with logging turned off because it is designed to monitor
populations under natural conditions. Population Growth & Productivity: Standard Logging,
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unlike the other experiments, permanently sets the four harvest parameters because it is designed
to monitor populations under current legal management practices for mahogany.

TN Experiment

Experiment name Population Growth & Productivity: Diameter Experiment

Vary variables as follows (note brackets and quotation marks):

["Logging" true]
["minimum-diameter" [40 10 90]]

Either list values to use, for example:

["my-slider* 1 2 7 8]

or specify start, increment, and end, for example:

["my-slider” [0 1 10]] (note additional brackets)

to go from 0, 1 at a time, to 10.

You may also vary max-pxcor, min-pxcor, max-pycor, min-pycor, random-seed.

Repetitions 100

run each combination this many times

Measure runs using these reporters:

count trees with [diameter >= 20] )
count trees with [diameter >= minimum-diameter] A
sum annual-harvest-number v

one reporter per line; you may not split a reporter
across multiple lines

" Measure runs at every step

if unchecked, runs are measured only
when they are over

Setup commands: Go commands:
setup run-model

Stop condition: Final commands:
the run stops if this reporter becomes true run at the end of each run

Time limit 0

stop after this many steps (0 = no limit)

( Cancel ) GO@ y

The other four Population Growth & Productivity experiments (Diameter, Retention,
Density, Cutting Cycle) vary each harvest parameter according to the syntax described above:
["harvest-parameter” [start increment end]]. To examine a different range or resolution of
parameter values, change the start, increment, and end values according to preference.
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Alternatively, values to be tested can be listed using the following syntax: ["harvest-parameter”
value value value ...]. For example, ["minimum-diameter" 50 55 60 75 80] would simulate the
non-incremental minimum diameters of 50, 55, 60, 75, and 80 cm. MAKE SURE YOU USE
THE BRACKETS EXACTLY AS SPECIFIED.

The Repetitions field specifies the number of simulations performed for each harvest parameter
value. The Population Growth & Productivity: Diameter Experiment simulates six
minimum diameter values (40, 50, 60, 70, 80 and 90 cm), each 100 times, for a total of 600
simulations. Type a new number into the Repetitions field to increase or decrease the
simulation sample size.

Experiment Reporters

The Measure runs using these reporters ficld designates the reporters, or measurements, used
to evaluate the simulated population. The reporters for the Diameter Experiment are repeated
in all other experiments (except Population Growth: No Logging which does not require
harvest reporters) as measures of population growth and harvest productivity:

count trees total tree abundance

count trees with [diameter >= 20] abundance of trees >= 20 cm diameter
count trees with [diameter >= minimum-diameter] abundance of commercial-sized trees

sum annual-harvest-number total number of logged trees

sum annual-harvest-volume total volume of logged trees
annual-harvest-number lists number of logged trees in each harvest
annual-harvest-volume lists volume of logged trees in each harvest

If you would like to remove a reporter from this list, simply delete it from the box. If you would
like to add or modify a reporter, refer to the sections below (sections 12.1 & 12.2). Note: a
method for reporting harvest number and volume values in individual columns is detailed in
section 12.2.

The reporters will be measured every year (time step) if the Measure runs at every step option
is selected. This would generate an unnecessary amount of data so the default setting leaves this
option unchecked. If you would like to track every year of every simulation, select this option.

Experiment Run Settings

The Setup commands and Go commands fields correspond to the commands in the model
procedure responsible for setting and running the model. DO NOT CHANGE THESE FIELDS.

The Stop condition and Time limit fields are left purposefully empty because both stop
conditions and time limits are already built into the model. It would be redundant to specify

them again here. DO NOT ENTER ANY VALUES OR COMMANDS IN THESE FIELDS.

The Final commands field can be used to export the model landscape, plots, and world at the
end of each model run. The export-view command exports the model landscape to an external
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image file. The export-plot and export-all-plots commands export either a specific plot or all
plots to an external .csv file. The export-world command exports the values of all variables, both
built-in and user-defined, including all observer, turtle, and patch variables and the plot contents.
The commands for exporting each feature are listed below:

export-view (word "Results/" "view " date-and-time " jpg")

export-plot "Tree Abundance" (word "Results/" "Tree Abundance " date-and-time ".csv")
export-all-plots (word "Results/" "plots " date-and-time ".csv")

export-world (word "Results/" "world " date-and-time ".csv")

The exported files are all written to the Model > Results folder. Each file type is saved with a
common identifier (i.e., ‘view’, ‘plots’, ‘world”) but the date and time extension varies between
runs in order to prevent file overwriting. The view image can be saved with any image extension
(.jpg, .png, .bmp, tif, etc) but the plots and world files must be saved with the .csv extension.

Step 5. Run BehaviorSpace Experiment

Run the chosen experiment by selecting the experiment in the BehaviorSpace window and
pressing the Run button. The Run Options window, shown on the next page, will open in the
center of your screen.

Check the Table output option and leave the Spreadsheet output option unchecked. Enter 2

into the Simultaneous runs in parallel field. The Table output option creates a more analysis-
friendly output and the Simultaneous runs in parallel option = 2 maximizes run efficiency.

8.0.0 Run options

__ Spreadsheet output
@ Table output

Simultaneous runs in parallel 2

If more than one, some runs happen invisibly in the background.
Defaults to one per processor core.

( Cancel ' (OK)

Press OK and save the output file anywhere on your computer. The output file must be saved as
a .csv or .xls file. INCLUDE THE .CSV OR .XLS FILE EXTENSION IN THE FILE NAME.

Step 6. Determine Run Settings
After saving the output file, the Running Experiment window will open in the center of your

screen. This window graphs the population metrics measured during the experiment and tracks
the progress of the experiment by reporting the number of completed steps and elapsed time.
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Run #4 of 600, step #53
Total elapsed time: 0:04:06
Logging = true
minimum-diameter = 40

@ Update view
@ Update plots and monitors

The graph will only be shown when measuring every time step; therefore, you will only see this
graph if you change the default experiment settings. The graph displays the measure of each
population metric over time, where the Behavior axis describes each metric. The metrics are
color-coded according to the legend on the right.

The output window below the graph tracks the experiment progress. The window reports the
number of completed runs and the number of completed steps, where each step represents a year.
The total elapsed time is also reported. The experiments take some time to run, so please be
patient.

The pace of the experiment can be accelerated by sliding the blue circle to the right, from
normal speed to faster speed. Turning off the visuals will also reduce processing time: uncheck
Update view and Update plots and monitors to further accelerate the experiment run time.

Pressing Abort will end the BehaviorSpace experiment. It is not possible to resume an aborted

experiment. To continue a BehaviorSpace experiment after pressing Abort, you will need to
start again from the beginning.
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Step 7. Format Data Output

The Running Experiment window will close when the experiment is completed, returning the
BehaviorSpace window to the center of the screen. Close the window and browse to the
experiment results file. The head of the experiment results file should look like this:

< A B C D
1 |BehaviorSpace results (NetLogo 4.1.1)
2 |Jimmy Model 3.1.nlogo
3 |Population Growth & Productivity: Standard Logging
4 112/26/2010 09:25:53:079 -0500
[ 5 |min-pxcor max-pxcor min-pycor max-pycor
6 -61 61 -86 86

This section of the file records basic information about the simulation experiment including: (1)
the version of NetLogo run; (2) the name of the model; (3) the name of the experiment; (4) the
date and time the experiment was run; and (5) the dimensions of the field site. Numbers in the
above list correspond to the line number in the experiment results file.

The field site dimensions are reported in terms of NetLogo patches but can be converted to
meters by multiplying each value by 10 meters. The length of the X-axis of the site is the sum of
minimum (min-pxcor) and maximum (max-pxcor) X-coordinate. The length of the Y-axis of the
site is the sum of minimum (min-pycor) and maximum (max-pycor) Y-coordinate.

Additionally, we recommend inserting a few lines under the header to record additional
information about the simulation experiment. For recordkeeping, it would be useful to record the
field site name, area, and dimensions, initial tree abundance and volume, and harvest years.

The rows below the header contain the data from the simulation experiment. The headings can
be rewritten for increased clarity based on the following recommendations or on user preference:

[run number] Run

Logging Logging (on/off)
minimum-diameter Minimum Diameter (cm)
retention-rate Retention Rate (%)
minimum-density Minimum Density (# / 100ha)
cutting-cycle Cutting Cycle (yr)

[step] Time (yr)

count trees # Trees

count trees with [diameter >= 20] # Trees (>20 cm diameter)
count trees with [diameter >= minimum-diameter] # Commercial Trees

sum annual-harvest-number # Logged Trees

sum annual-harvest-volume Logged Tree Volume (m?)
annual-harvest-number Harvest Number List (# / yr)
annual-harvest-volume Harvest Volume List (m® / yr)
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If you would like to query the model for additional information, please refer to Command Line
and BehaviorSpace Experiments below (sections 12.1 & 12.2).

Step 8. Analyze Simulation Data

Before analyzing the data, you may be interested in adding a few data columns, such as total
density, commercial density, and harvest year statistics. The abundance (count) values can be
converted to density values using the following formula:

Density = Abundance / Site Area * 100
where site area is measured in hectares (ha) and density is measured in trees per 100 hectares.

The harvest number and volume lists can be broken into individual years using the Text to
Columns feature available in most spreadsheet programs. First, highlight the two list columns
and use the Find and Replace feature to remove the brackets (‘[’) from the cells. Then, use the
Text to Columns feature, with data delimited by spaces, to convert the text data to column data.
This will better facilitate the examination of harvest productivity across time.

The post-processing of the harvest value lists can be avoided by using the directions in Harvest
List Reporters of BehaviorSpace Experiments (section 12.2) to report the harvest list values in
individual columns as opposed to single column list. Label these new columns accordingly.

The analysis of the experiment data should be performed according to your familiarity with
statistics. A thorough review of statistical analysis is beyond the scope of this User Manual;
however, simple statistics, such as average and standard deviation, should suffice most of the
time. For example, a comparison of the average final commercial density to the initial
commercial density is a simple but powerful statistical method.

Similarly, calculating the average logged volume from each harvest year provides a simple but
powerful summary of harvest productivity over time under different harvest regimes. A standard
deviation of these averages would provide an estimate of confidence. The BehaviorSpace
experiments provide a large sample size and these simple statistics can convey much information
about population growth and harvest productivity.

12 ADVANCED USERS & NETLOGO RESOURCES

12.1 Command Line Code

The following section provides an introduction to using the Command Center to query the
landscape for information not displayed in the population monitors or plots or harvest monitors.

Commands are entered in the command line window, the small window labeled observer>,

shown on the next page. The results of the commands are printed in the larger output window
labeled Command Center.
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Command Center W@ | Clear

observer> show count trees

observer: 143

observer> show count trees with [diameter >- 60]
observer: 87

observer> show sum [volume] of trees with [diameter >~ 60] - p.

Copy and paste any of the italicized commands listed below into the command line window.
Press Return/Enter to run the command. ALWAYS LEAVE THE COMMAND LINE IN
OBSERVER MODE. DO NOT SUBMIT COMMANDS IN TURTLES, PATCHES, OR
LINKS MODES.

You can access previous commands using the history popup menu, the small downward pointing
triangle to the right of the command line window. Press the triangle to see a menu of previously
entered commands. Alternatively, you can access previous commands with the UP and DOWN
keys on the computer keyboard, as long as the cursor is in the command line window.

Pressing the Clear button in the upper-right corner of the Command Center window will erase
the contents of the output window. Additionally, the Command Center can be resized by
grabbing and moving the gray bar at the top of the Command Center window.

The following is a list of commands that may be useful to your analysis. For sections with bold
italicized commands (i.e., grow-trees, kill-trees, log-trees, etc.), you must enter the bold
italicized command before entering the other commands. The commands can be modified using
the statements at the bottom of the summary to more powerfully query the model results.

Population Statistics

Total Tree Abundance show count trees

Commercial Tree Abundance show count trees with [diameter >= 60]
First-Year-Seedling Abundance show count trees with [seedling? = true]

Total Tree Volume (m’) show sum [volume] of trees

Maximum Tree Basal Area (cm?) show max [basal-area] of trees

Median Small Tree Diameter (cm) show median [diameter] of trees with [diameter <= 20]
Initial Population Abundance show y0-tot-density * site-area / 100

Initial Population Density show y0-tot-density

Initial Commercial Abundance show y0-comm-density * site-area / 100

Initial Commercial Density show y0-comm-density

Commercial Density (trees / 100ha)  show count trees with [diameter >= 60] / site-area * 100
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Field Site Statistics
Field Site Area (m?)
Field Site Area (ha)
Field Site Area (km®)

Field Site Width (m)
Field Site Width (km)
Field Site Height (m)

Growth Statistics: grow-trees
Specific Tree Growth Rate (cm/yr)
Median Tree Growth Rate (cm/yr)
Fastest Growing Tree Diameter (cm)

Fastest Growing Tree (tree #)
Smallest Basal Area Tree (tree #)
Large DBH Trees (tree #s)

Harvest Statistics: log-trees

Free Landis & Grogan, Mahogany Growth & Yield

show site-area * 10000
show site-area
show site-area / 100

show world-width * 10
show world-width * 10/ 1000
show world-height * 10

show [growth-rate] of tree 17
show median [growth-rate] of trees
show [diameter] of trees with-max [growth-rate]

show [who] of trees with-max [growth-rate]
show [who] of trees with-min [basal-area]

show [who] of trees with [dbh > median [dbh] of trees]

Last Harvest: Number of Logged Trees show length cur-logged-volume
Last Harvest: Total Logged Volume (m’) show sum cur-logged-volume
Last Harvest: Largest Logged Tree Volume (m®)  show max cur-logged-volume

All Harvests: Number of Logged Trees show length tot-logged-volume
All Harvests: Total Logged Volume (m?) show sum tot-logged-volume
All Harvests: Largest Logged Tree Volume (m®)  show max tot-logged-volume

Number of Trees Logged in Harvest Number X show item ((X) - 1) annual-harvest-number
Volume of Trees Logged in Harvest Number X show item ((X) - 1) annual-harvest-volume

tot-logged-volume = a list of the volumes of trees logged during all previous harvests
cur-logged-volume = a list of the volumes of trees logged during the most recent harvests
annual-harvest-number = a list of the number of trees logged during each harvest year
annual-harvest-volume = a list of the volume of trees logged during each harvest year

Mortality Statistics: kill-trees
Specific Tree Mortality Probability
Median Tree Mortality Probability
Live Tree Mortality Probabilities

Dead Tree Abundance
Large Dead Tree Abundance
Dead Tree Diameter List (cm)

show [mort-rate] of tree 17
show median [mort-rate] of trees
show [mort-rate] of trees with [alive? = true]

show count trees with [alive? = false]

show count trees with [alive? = false and diameter >= 60]
show [diameter] of trees with [alive? = false]
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Disturbance Statistics: disturb-trees
Landscape Disturbance (%) show count patches with [disturbance? = true] / count patches
Landscape Sweetspot (%)  show count patches with [sweetspot? = true] / count patches

Landscape Disturbance (ha) show count patches with [disturbance? = true] * 100/ 10000
Landscape Sweetspot (ha)  show count patches with [sweetspot? = true] * 100/ 10000

Reproduction Statistics: reproduce-trees
Reproductive Tree Abundance show count trees with [reproduce? = true]

Mean Reproductive Tree Diameter show mean [diameter] of trees with [reproduce? = true]

Max. Large Tree Fruit Probability  show max [fruit-prob] of trees with [diameter <= 30]

Median Fruit Production show median [num-fruit] of trees with [reproduce? = true]
Potential Seed Production show floor (sum [num-fruit] of trees * seeds-per-fruit)
Actual Seed Production show sum [surv-seeds] of trees

Disturbance / Seedling Datasets

Median Disturbance Area (m?) show median disturbance-dataset
Disturbance Dataset Sample Size  show length disturbance-dataset
View Disturbance Dataset show disturbance-dataset

Mean First-Year-Seedling Diameter show mean seed-diam-list

disturbance-dataset = a list of the disturbance area sizes (m?) observed in the field site
seed-diam-list = a list of first-year-seedling diameters (cm) observed in the field

*The seedling diameter and disturbance size data distributions can be viewed in the Model >
Data folder. The seedling diameter distribution file is called seedling-data.csv while the
disturbance size distribution file is called gap-data.csv.

Export Data

Export Landscape Image (.jpg) export-view user-new-file

Export Interface Image (.jpg) export-interface user-new-file

Export Output Text (.txt) export-output user-new-file

Export Single Plot Values (.csv) export-plot "Tree Abundance" user-new-file
Export All Plot Values (.csv) export-all-plots user-new-file

Export All Variables (.csv) export-world user-new-file

*Name and place the exported file anywhere on your computer. Include the file extension listed
in the parenthesis following each export method.

Available Statements

Math Statements < > = = <= >=

Logic Statements true, false

Statistic Statements max, min, mean, median, modes, with-min, with-max
Patch Variables disturbance?, sweetspot?
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Tree Variables who, alive?, seedling?, reproduce?, diameter, dbh, basal area,
volume, growth-rate, mort-rate, fruit-prob, num-fruit, surv-seeds

These statements can be substituted for similar statement types in the ifalicized commands
provided above. For example, any statistical statement (max, min, mean, etc.) can replace a
statistical statement in the provided commands. Likewise, any tree variable (alive?, diameter,
mort-rate, surv-seeds, etc.) can replace a tree variable in the provided commands.

12.2 Modifying BehaviorSpace Experiments

SIMULATION EXPERIMENTS: BehaviorSpace (section 11) provides a thorough review of
the NetLogo BehaviorSpace feature. If you are interested in personalizing the built-in
experiments further, or in creating your own experiments entirely, please review the section
below.

Varying Multiple Parameters

Pre-defined BehaviorSpace experiments are designed to test either a single harvest regime or to
test the sensitivity of population growth & yield to a single harvest parameter. It is also possible
to examine multiple harvest regimes within a single simulation experiment. This can be
achieved by varying more than one harvest parameter in the BehaviorSpace variable settings.

For example, rather than only varying minimum-diameter, both minimum-diameter and
retention-rate could be varied using the following code:

["minimum-diameter"” [40 10 80]]
["'retention-rate” [10 5 30]]

The BehaviorSpace experiment would simulate each combination of minimum-diameter and
retention-rate for the specified number of repetitions. In other words, each minimum diameter
cutting limit, beginning with 40 cm and ending with 80 cm at 10-cm increments, would be
simulated with each retention rate, beginning with 10% and ending with 30% at 5% increments.

This design can be implemented with all four harvest parameters to simulate the outcomes of
multiple harvest regimes. Although it generates many runs, and therefore requires a lot of
processing time, it collects the results in a single spreadsheet for quick analysis.

Adding New Reporters

The built-in experiments can also be personalized by adding new reporters or stop conditions to
the experiment settings. New reporters can be added from those listed in Command Line Code
(section 12.1) although reporters requiring bold italicized commands will not generate

meaningful data since BehaviorSpace reporters are measured at the end of each run.

Copy and paste the Command Line reporters (exclude show from the reporter) into the
BehaviorSpace reporter settings. For example, rather than pasting show median [diameter] of
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trees with [diameter <= 20], only paste median [diameter] of trees with [diameter <= 20].
These reporters will provide even more information when running the experiments.

Harvest List Reporters

The annual-harvest-number and annual-harvest-volume reporters prints a list of harvest values
in two columns as [itemy,; item . item 3 item j4 ...] Where each item,, represents the harvest value
for harvest number x. If you prefer that each item receive its own column, you must replace the
annual-harvest-volume reporter, for example, with the following reporters:

item 0 annual-harvest-volume volume of logged trees in harvest 1
item 1 annual-harvest-volume volume of logged trees in harvest 2
item 2 annual-harvest-volume volume of logged trees in harvest 3
item (1 — X) annual-harvest-volume volume of logged trees in harvest X

The item code numbers items in a list from zero onwards so item 0 is harvest 1, item 1 is harvest
2, item 3 is harvest 4, etc. You must enter an item reporter for each expected harvest. You can
determine the expected number of harvests using the following formula:

floor (Time Limit / Cutting Cycle) + 1
where the ‘floor’ of a number of harvests is the largest integer less than or equal to the number.
Adding Stop Conditions

If you are interested in including stop conditions different from the defaults, which stop
simulations after the time limit or when all trees die or are harvested, whichever happens first,
you can enter new conditions in the Stop condition prompt. The model stops when conditions
become true. For example, if you want to halt simulations after the first harvest, you would
enter: length annual-harvest-number > (. Alternatively, if you want to halt simulations when
commercial abundance falls below a certain threshold, you would enter: count trees with
[diameter >= minimum-diameter] <= 10.

More information on BehaviorSpace experiments can be found on the NetLogo website or in the
NetLogo User Manual. Please see NetLogo Resources (section 12.4) below.

12.3 Model Procedure Code

This section provides insight into both modifying and understanding the underlying model code.

A fully annotated version of the model code is available in APPENDIX D: MODEL CODE
(page 57) and in the Procedures tab of the NetLogo interface. A close review of the code will
help you better understand how the model works. NetLogo Resources (section 12.4) provides
additional information towards understanding the code.
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Procedure Summary

The gray text, preceded by repeat semi-colons (;;), represents comments provided to guide you
through the model code. This text is not read by the computer and is included only to explain the
functional model code. The head of the model code provides basic information about the model:
the title, the authors, the funders, the landscape dimensions, etc.

The first section of real code, EXTENSIONS, BREEDS, AND VARIABLES, identifies code
extensions and variables used throughout the model. Code extensions activate code types not
included in the default language as well as variables used throughout the model to modify trees
and the landscape. Global variables are constant values used to make these modifications; these
are the only variables we suggest that you modify, as explained below.

MODEL SETUP, the second section of code, sets up the model by checking for errors, setting
variable values, drawing the landscape, setting the plots and monitors, and establishing the initial
population on the landscape. These steps happen in discrete sections of code known as
procedures, bounded by the keywords to and end. Each step is explained thoroughly in the
model code.

The third and final section of code, RUN MODEL, successively grows, kills, disturbs, and
reproduces trees on the landscape. This section also contains the code for exporting data and
resetting the trees and landscape for the next year of simulation. These steps are also contained
within procedures and each procedure is extensively commented in the model code.

Procedures -« In the Procedures tab of the NetLogo interface, use the Procedures menu to
view a list of model procedures and zoom to a specific procedure.

Procedures are color-coded according to the following scheme: keywords are green; constants
are orange; comments are ; built-in NetLogo commands are blue; primitive reporters are
purple; and everything else is black.

Modifying Global Variables

It is possible to modify the growth & yield model using alternative data to calculate alternative
regressions, but explaining this process is beyond the scope of this User Manual. If you intend to
modify model functions, we recommend that you modify only global variables (model
constants). Global variables are set in the first section of code and are briefly summarized
below.

Variable Value Definition

prop-dist 0.026  the proportion of the landscape disturbed each year

seed-radius 5.382  the radius of a 0.91-ha seed shadow in patches (1 patch = 10 m)
max-num-fruit 750 the maximum number of fruit per tree

seeds-per-fruit  42.4 the average number of viable seeds per fruit

surv-prob 0.085  the proportion of seeds surviving to become first-year seedlings

41



Free Landis & Grogan, Mahogany Growth & Yield

To change the value of any of these constants, simply replace the old value with a new one.
Remember to rename the new model when saving to avoid overwriting the original model.
OVERWRITING THE ORIGINAL MODEL WILL FORCE YOU TO REINSTALL THE
MODEL.

The ability to redefine global variables is useful for personalizing the model constants to your
field site. For example, if you think your site experiences more disturbance, increase the
proportion of landscape disturbance (prop-dist) value. Similarly, if you think the trees in your
site have a smaller maximum fruit output (max-num-fruit) or produce fewer viable seeds per fruit
(seeds-per-fruit), you can reduce these values.

12.4 NetLogo Resources

NetLogo is a multi-agent programmable modeling environment developed by Uri Wilensky at
the Center for Connected Learning and Computer-Based Modeling (Wilensky 1999). If you are
interested in learning more about the software, please visit the NetLogo website:
http://ccl.northwestern.edu/netlogo/index.shtml

The website includes resources for learning NetLogo including a User Manual, online dictionary,
example models, and publications. The NetLogo Users Group, an online community of NetLogo
users, is also available for help and advice: http://groups.yahoo.com/group/netlogo-users/

The NetLogo software comes with a Models Library, available in Files > Models Library in
the NetLogo menu. These models can be used as examples or templates for learning the
NetLogo language, modifying the growth & yield model, or creating new NetLogo models.

NetLogo 4.1.2, the version used to run the Big-Leaf Mahogany Growth & Yield Model, can be
downloaded here: http://ccl.northwestern.edu/netlogo/4.1.2/. The most recent version of the
software can be downloaded here: http://ccl.northwestern.edu/netlogo/download.shtml

13 LIMITATIONS & CONSIDERATIONS

The Big-Leaf Mahogany Growth & Yield Model functions are derived from demographic data
collected annually from 1995-2009 for nearly 600 mahogany trees and many thousands of
seedlings, saplings and poles at multiple field sites in southeast Pard and Acre. This
comprehensive dataset allows for robust predictions of mahogany population growth & yield
outcomes over reasonable time periods. Even so, it is important to acknowledge model
limitations that constrain the accuracy and precision of projected outcomes.

First, due to the scarcity of natural regeneration in gap environments, simulated seedling/sapling
mortality and growth rates in large gaps are based on data from experimental outplantings across
light gradients in large clearings initiated at Marajoara in 1995. These data present optimistic
estimates of juvenile performance due to manual removal of competing vines and secondary
vegetation during the experiments’ initial three years.
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Second, population outcomes are highly sensitive to disturbance, and the model’s disturbance
function is derived from data collected during a single year at Marajoara. Because disturbance
regimes vary widely across time and space, this data only partially represents the temporal and
spatial extent of gap-forming disturbance events necessary for mahogany regeneration and
recruitment to adult size.

Finally, the model does not formally incorporate density-dependent population regulation, which
may allow overestimation of population growth & yield. Steniscadia poliophaea, a nocturnal
specialist moth, preys more regularly and intensely upon mahogany seedlings in close proximity
to large fruiting trees or groups of clumped adults. The population-level influence of this
density-dependent seedling predator could be strong if population growth is sensitive to
observed reductions in seedling survival and growth. As well, impacts on population growth of
the mahogany shootborer, Hypsipyla grandella, cannot be directly accounted for in the model due
to lack of data addressing this issue. Density-dependent seedling mortality has been shown to
reduce population growth rates in other neotropical trees.

14 FUTURE MODIFICATIONS

We are interested in using the recently published R Extension for NetLogo (Thiele & Grimm, in
press: http://netlogo-r-ext.berlios.de/) to increase the robustness of the model regressions, the
potential for in-model data analysis, and the functionality of the Export Results command.

We also plan to make the model run faster by improving the processing efficiency of the
disturbance and reproduction functions. Similarly, we plan to include more built-in example
populations and to streamline the user data upload process.

The online version of the model will be continually updated as the computer version of the
model becomes more compatible with the web server and applet export services.

Future versions of the model may also be improved according to user feedback and
recommendations. Please take the user survey listed on our website: http://www.swietking.org
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If you have questions about the model, please email Chris Free: cfree@swietking.org. If you are
unable to email, questions can be directed to:
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44 Cave Hill Rd Apt 2
Leverett, MA 01054 USA
Tel: +1-413-548-8180

More information on our research can be found on our website or in the publications above:

http://www.swietking.org
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APPENDIX A: DATA SOURCES

This research program’s principal study site, Marajoara, is a forest industry-owned management
area in southeast Para, Brazil (7°50' S, 50°16' W). The site was selectively logged for mahogany

between 1992-1994. Model demographic parameters are derived from a sample mahogany
population consisting of 358 surviving trees > 10 cm diameter in an area of 2050 ha. These trees
were censused annually for survival, stem diameter growth, and fruit production from 1997-
2010. Other phases of mahogany’s life cycle, including temporal and spatial patterns of seed
dispersal, seed germination, and seedling establishment rates, were quantified in observational
and experimental studies at Marajoara. Fruit production data are supplemented by observations
of ~325 mahogany trees at three additional sites in southeast Par4 and at the Acre/West Amazon
site. Because few large (> 100 cm diameter) adult trees survived logging at Marajoara or were

available for observation at the other study sites, fruit production data are supplemented with
data from Gullison et al. (1996).

The example populations, discussed at greater length in section 6.1, were derived from: a 100%-
area inventory of mahogany trees > 20 cm diameter in a 204-ha subplot of the Marajoara field
site; a randomly stratified transect survey of mahogany trees > 20 cm diameter in 1035 ha at
Marajoara (10% of the total area); and a 100%-area inventory of mahogany trees > 20 cm
diameter in 685 ha at the Acre/West Amazon site. Due to selective logging prior to the study,
mortality and growth rates may reflect a small post-logging increase.

Due to the scarcity of natural regeneration in gap environments, simulated seedling/sapling
mortality and growth rates in large gaps are based on data from experimental outplantings across
light gradients in large clearings initiated in 1995. These data present optimistic estimates of
juvenile performance due to the manual removal of competing vines and secondary vegetation
during the experiments’ initial three years.

Canopy disturbances are simulated based on an observed size distribution of gap-forming canopy
gaps during 1996-1997 at Marajoara.
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APPENDIX B: MODEL DETAILS & DEFINITIONS

MODEL FEATURES
*.c Button Button: A button executes instructions when pressed. Setup, Defaults, Run
et Slider 1 Year, Run X Years, Resize, All Definitions, Export Results, ?, etc., are
iS5 switch all buttons.
¥51 Chooser
- "‘ilflli_t Slider: A slider allows selection from a range of values. The model has
B Monitorsliders for Time and LOGGING PARAMETERS.
.~ Plot
E=] Qutput

e Switch: A switch allows a variable to be turned on/off. The Logging switch
Lol L turns the logging function on/off before simulation.

Chooser: A chooser allows a user to choose among variable values. The Populations chooser
allows the user to select between three example populations and three user-defined population
options.

Input: An input box allows the user to type in a value for a variable. There are two types of
inputs: number and text. The Site-Width, Site-Height, and Patch-Area input boxes accept
number inputs. The File-Name and DIAM-Attribute-Name input boxes accept text inputs.

Monitor: A monitor displays the value of a built-in expression. The Area, Population, and
Harvest Productivity monitors report the area of the field site, the density/volume of trees in the
initial and current populations, and the number/volume of trees logged during harvests.

Plot: A plot provides a real time graph of model results. The Diameter Distribution plot tracks
the size distribution of the population and the Tree Abundance plot tracks tree abundance.

Output: An output provides a text window on the model interface. The Definitions output
provides definitions of the interface features when the ? (Help) buttons are pressed.

Note: A note provides text labels for each section of features. MODEL SETTINGS,
LOGGING PARAMETERS, YEAR 0 POPULATION, etc., are all provided to organize and
structure the interface.

INTERFACE DEFINITIONS (see schematic, page 3)

MODEL CONTROL BAR

! Interface | Information Procedures |

g 3 g - g e G . ™ view updates

*ae Button w

. B | (‘settings... )
Edit Delete Add u normalspeed »Continuous .: i PrCCeiieSy Sy

The Interface tab displays model controls and simulations.
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The Information tab displays a basic information about the model.
The Procedures tab displays the workspace where the model code is stored and modified.

Edit: This button is only active when a feature is selected on the interface. Pressing the button
allows the selected feature to be edited. Use it to modify the range/increment of a harvest
parameter.

Delete: This button is only active when a feature is selected on the interface. Pressing the
button will delete the selected feature. Do not use this button! All features are necessary to the
model.

Add + Button: In combination, these add buttons, sliders, switches, choosers, inputs, monitors,
plots, outputs, or notes to the interface. First press Add and then Button to choose a feature
from the pop-up menu.

normal speed: This slider determines the speed of model runs. Slide the round knob left for
slower, slide right for faster.

view updates: Determines whether landscape updates are shown. When checked, you can view
continuous updates or on ticks updates (that is, at the end of each year). Unchecking view

updates yields faster model runs.

Settings: Determines the size, shape, and resolution of the landscape, and sets the time unit.

MODEL CONTROLS

MODEL CONTROLS

Setup Establishes initial population on landscape.

Defaults Resets harvest and other parameters to default conditions.

Populations Lists selection of example and user-defined initial populations.

Site Area Area of selected site in hectares (ha).

Logging Determines whether logging is on/off during the simulation(s).

Time Number of years the model will simulate.

Run 1 Year Runs the model for one year.

Run X Years Runs the model until time limit or all trees are harvested or die.

? Help button returns definitions for a given model section.

LOGGING PARAMETERS

Minimum-Diameter The minimum diameter of commercial trees (cm).

Retention-Rate The retention rate of commercial-sized trees (%).

Minimum-Density The minimum post harvest density of commercial-size trees
(trees / 100 ha).

Cutting-Cycle The number of years between harvests.
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YEAR 0/ CURRENT POPULATION*

Total Density
Commercial Density
Commercial Volume
Diameter Distribution

Tree Abundance

The density of trees > 20 cm diameter in the field site (trees / 100 ha).
The density of commercial-sized trees in the field site (trees / 100 ha).
The volume of timber in the commercial population (m”).

Bar columns = 10-cm diam increments; gray line = commercial diam.
Black = initial size distribution; red = current size distribution.
Vertical gray lines = harvest years.

Black = total tree abundance; red = commercial tree abundance.

HARVEST PRODUCTIVITY

Logged Volume
Total Logged Volume
Total # Logged Trees

DATA UPLOAD
File-Name
DIAM-Attribute-Name
Site-Width

Site-Height
Patch-Area

Resize

DEFINITIONS
All Definitions
Export Results

The volume of trees logged in the most recent harvest (m?).
The volume of trees logged in all previous harvests (m”).
The number of trees logged in all previous harvests.

Name of user data file with diameter and or XY data.
Name of the diameter attribute in the user shapefile.
The width (X) of the user field site (meters).

The height (Y) of the user field site (meters).

The size of the patches on the landscape (pixels).
Resizes the landscape based on the ‘Patch-Area’ listed.

Displays the definition/function of all features on the interface.
Exports simulation results to a user named and located file.

* Commercial-sized trees, or commercial trees, are trees whose diameters are larger than the
minimum diameter cutting limit, or minimum-diameter. Note that in both Diameter
Distribution and Tree Abundance plots, no trees < 20 cm diameter are shown.

COMMAND CENTER

Command Center W@ | Clear
observer> show count trees

observer: 118

observer> show count trees with [diameter >- 60]

observer: 15

observer> show sum [volume] of trees with [diameter >~ 60] - p,

The Command Center allows commands to be issued directly, without adding them to the
model’s procedures. This is useful for extracting more specific information about the population
than default outputs provide.
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observer>: This pop-up menu specifies the Command Center mode. It can be changed to
turtles, patches, or links modes, but should be left in observer mode.

¥ Click on the History triangle to browse and select from previously typed commands.

Y| This button switches the Command Center window between vertical window and
horizontal views. Other resizing options include: Drag the gray bar separating the window from
the interface to a new position. Or, press the small gray arrows above the ‘Clear’ button to hide
the window or make it very large.

Clear: Press this button to clear the contents of the Command Center window. To clear the
History pop-up menu, choose ‘Clear History’ in the menu options.
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APPENDIX C: MODEL FUNCTIONS

This section provides an in-depth review of how the model functions. APPENDIX D: MODEL
CODE provides a similar review alongside the actual model code. The fully annotated model
code is also available in the Procedures tab of the NetLogo interface.

Initial Population

The model begins with an initial population selected by the user and represented on the NetLogo
landscape. The landscape is contained within a box where each cell represents a 10 m x 10 m
(100 m?) patch on the landscape; disturbances and seeds dispersed over a landscape edge are not
returned to the other side. Because the model is spatial, the arrangement of trees on the
landscape is significant in determining simulation outcomes.

At each time step (one year), the following demographic parameters are estimated for each tree
based on regression equations derived from field census data: (1) diameter increment (cm yr');
(2) mortality probability; (3) probability of fruit production; and (4) number of fruit produced.
The model simulates logging, growth, mortality, disturbance, and reproduction each year with
these parameters until the time limit is exceeded or all trees are harvested or die.

Growth Function

The growth function incorporates growth autocorrelation, the tendency of fast-growing trees to
remain fast growing, in order to account for past growth history. Diameter increment is
estimated as a function of stem diameter using generalized least squares to incorporate an
autoregressive error term, accounting for growth autocorrelation over the preceding three years.

The trees begin the simulation with no growth history, so three residuals e/ (1-year previous), e2
(2-years previous), and e3 (3-years previous) are assigned an identical random number drawn
from the distribution N(0, 0.48). The present year residual, e0, is calculated as the following:

e0 = (0.467 *el) + (0.247 *€2) + (0.111 *e3) + o (1)

where g ~ N(0, 0.48). The residuals are recalculated each time step because, as a year passes, the
residual of the previous year becomes the residual of two years before. The residuals are
therefore recalculated as e3 = e2, e2 = el, el = el, and e0 = the value of the above equation
calculated with the new residual values. The growth rate, or diameter increment, of each tree is
then calculated using the following equation:

growth rate (cm yr'') = 0.36 + (diameter * 0.011) — (0.0127 * max(0, diameter — 30)) + e0 (2)

where the max(0, diameter — 3() evaluates to zero when a tree is < 30 cm diameter and evaluates
to (diameter — 30) when a tree is > 30 cm diameter. The resulting diameter increment is added to
the current diameter to calculate the new tree diameter. A diameter increment < 0 is reclassed as
0 given the impossibility of negative growth.
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Logging Function

The logging function removes eligible trees from the population at the beginning of the
simulation and during the subsequent harvest years, as determined by the cutting cycle
parameter. The function removes the maximum possible number of trees larger than minimum
commercial size without violating either the retention rate or post-harvest density requirements.
Half of logged trees are allowed to disperse seeds prior to death and all logged trees create
canopy gaps proportional to stem diameter based on the equations in the Mortality Function
section below.

Mortality Function

The mortality function estimates the probability of mortality as a binary logistic regression of the
current year stem diameter and diameter increment using the following equation:

log-odds(mortality) = —2.11 — (1.337 * growth-rate) — (0.107 * diameter) + 3)
(0.1305 * max (0, diameter — 23)) — (0.0197 * max (0, diameter — 86))

which is subsequently used to calculate the probability of mortality with the logit transformation:
mortality probability = (exp log-odds) / (1 + (exp log-odds)) (4)

where the fate of each tree is determined by comparing its probability of mortality to a random
number between 0 and 1. If the randomly selected number is smaller than the probability of
mortality, the tree is marked as dead.

Before its removal from the population, a dead tree is given a 50% chance of dying standing and
a 50% chance of dying before seeding. A tree dying after seeding will fruit and disperse seeds
before being removed from the population, whereas a tree dying before seeding will be removed
from the population without fruiting. A tree dying standing will be removed from the population
without creating a treefall gap, whereas a tree resulting in a treefall gap will create a disturbance
area according to the following equation:

disturbance area (m’) =—=25.171 + (1.398 * dbh) + (0.02 * dbh"2) &)
where dbh, or diameter at breast height (1.3 m), is calculated from diameter as follows:

dbh (cm) = (diameter — 0.2842709) / 1.1003362 (6)

The radius of the disturbance area is calculated using the equation for the area of a circle, a =
nr>.  The zone of recruitment, that is, the area of the disturbance available for seedling
recruitment, is estimated to be 10 m shorter in radius than the radius of the disturbance area. The
resulting disturbance and zone of recruitment areas are constructed on the landscape using the
tree as the center of the each circular area.
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Disturbance Function

Canopy disturbances and the associated zones of recruitment are added to the landscape until
0.026 of the landscape is disturbed, including disturbances from fallen trees. Disturbance sizes
are drawn from a gamma distribution fit to an observed size distribution of gap-forming canopy
disturbances (n = 87; shape: 0.6127; scale: 0.0056). The radius of the zone of recruitment is 10
m less than the radius of the disturbance; therefore, a disturbance with a radius > 10 m is
necessary to for recruitment. The zones of recruitment represent the only viable areas for
recruitment on the landscape as recruitment does not occur in the forest understory or on the
outer edge of canopy disturbances.

Reproduction Function

Fruiting probability is estimated as a binary logistic regression of the current year stem diameter
and diameter increment of trees marked as reproductive (all non-seedling trees and 50% of dead
trees) using the following equation:

log-odds(fruiting) = —6.13 + (diameter * 0.1177) + (—0.1079 * max (0, diameter — 50)) (7)
+ (growth-rate * 2.796) + (—2.957 * max (0, growth-rate — 0.75))

which is subsequently used to calculate the fruiting probability using the logit transformation:
[fruiting probability = (exp log-odds) / (1 + (exp log-odds)) (8)
If fruiting occurs, fruit production is estimated as a function of current year stem diameter and
diameter increment in a generalized linear model with a gamma error term. The gamma
distribution function is parameterized with the scale and shape factors, alpha (o) and lambda (A).
The o value is a constant 1.22 while the A value is calculated as a function of the mean number

of fruit and the variance of this mean. The mean number of fruit and variance of the mean for a
tree of any given diameter are calculated as follows:

mean-fruit = exp (0.2933 + (0.03153552 * diameter) + 9
(0.00025 * diameter™2) — (1.514 * 10"—6 * diameter”3))

variance-fruit = 0.822 * mean-fruit"2 (10)
These values are subsequently used in the calculation of A, which, in conjunction with ¢, is used

to calculate the gamma distribution describing the distribution of fruit production values for a
single tree. These two equations are as follows:

lambda = (1 / (variance-fruit / mean-fruit)) (11)
number of fruit produced = gamma(a, A) (12)

where fruit production by a given tree is capped at 750 to avoid unrealistically high values.

55



Free Landis & Grogan, Mahogany Growth & Yield

Once fruit production is determined for surviving reproductive trees, new seedling recruits are
added to the population based on the following equation:

1-year-oid seedlings = L=y fruit; - s; i * foapi * fourw (13)

where n is the number of reproductive trees in the population, fruit; is the number of fruit
produced by tree i, s 1s the mean number of seeds per fruit, f,q,:1s the fraction of seeds landing
in gaps for tree i, and fy, 1s the fraction of seeds that germinate and survive to become 1-year-
old seedlings. sj.i and fu,. are constant values of 42.4 and 0.085, respectively, based on
observations at the Marajoara field site. The f,,,; fraction represents the proportion of the 0.91-
ha seed shadow overlapped by zones of recruitment of contributing treefall gaps and natural
disturbances. The resulting number of surviving seeds is divided by the number of zone of
recruitment patches within the seed shadow. Each zone of recruitment patch receives the
resulting number of 1-year-old seedlings with diameters drawn randomly from an observed
distribution of seedling diameters.

Model Reset Function

The final function in the model procedure resets the trees and landscape before beginning the
process again during the next time step (the next year). First, all dead trees and disturbances are
removed from the landscape. Second, the tree variables associated with reproduction — fruiting
probability, fruit production, and number of surviving seeds — are reset to default values to
prevent the values of a reproductive year from carrying over into a non-reproductive year.
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APPENDIX D: MODEL CODE

This section provides a fully annotated copy of the model code. This code is identical to the
code in the Procedures tab of the NetLogo interface. The structure of the model code is
summarized in Model Procedure Code (section 12.3) and reviewed briefly below.

The head of the model code provides basic information about the model: the title, the authors, the
funders, the landscape dimensions, etc. The EXTENSIONS, BREEDS, AND VARIABLES
section declares the code extensions and variables used throughout the model. The MODEL
SETUP section sets up the model by checking for errors, setting variable values, drawing the
landscape, setting the plots and monitors, and establishing the initial population on the landscape.
The RUN MODEL section successively grows, logs, kills, disturbs, and reproduces the trees on
the landscape. This section also contains the code for exporting data and resetting the trees and
landscape for the next year of simulation.

The procedures are color-coded according to the following scheme: keywords are GREEN;

constants are ORANGE; comments are ; built-in NetLogo commands are BLUE; primitive
reporters are PURPLE; and everything else is BLACK.
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